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Introduction 
This handbook is intended as a short, basic introduction to the functions and 
features of LiquiChip® Analyzer software. It is divided into two sections. The 
initial section (pages 4–15) gives a brief introduction to the features of the 
software and enables the user to load, analyze, and export data generated 
using a LiquiChip Reader or similar xMAP® instrument.  

Advanced features of the software are addressed in the second section (pages 
16–26). 

The LiquiChip Analyzer Software enables fast analysis and quantification of 
LiquiChip xMAP assays. Raw data is input as an output.csv file. Easy-to-use and 
intuitive environments let researchers define plate locations of standards, 
controls, and unknowns. Once information on standard concentrations is 
entered, concentrations of analytes are calculated using either a user-defined or 
best curve fit algorithm. Results can be exported in tabular or graph form. 

Generating Raw Data Using Luminex IS 2.3. 
Software 
Creating and running an advanced batch is described in the IS 2.3 Software 
User Manual 03/2006. Data are saved exclusively in the output.csv and run file 
and can be further analyzed or examined using the IS 2.3 Software. 

Creating a template for assays that give raw data only is described on page  
5-137 of the QIAGEN LiquiChip Workstation User Manual. 

Creating a batch is described on page 5-62 of the QIAGEN LiquiChip 
Workstation User Manual. 

To generate raw data suitable for analysis using LiquiChip Analyzer Software:  

 The “Enable Raw Data Storage” box must be checked in the “General” tab 
of the “Options” dialog box. 

 The “Trimmed %CV” box must be checked in the “Data Export” tab of the 
“Options” dialog box. 
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Screen Architecture 
LiquiChip Analyzer software is based on familiar Windows® type architecture. 
Figure 1 shows the typical architecture of the LiquiChip Analyzer Software 
screen. 

 

 

 

 
Figure 1 LiquiChip Analyzer Software screen architecture. 

Environments 
shortcuts panel 

Toolbar Environment tab Environment windows 
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LiquiChip Analyzer Software Environments 
The LiquiChip Analyzer Software contains eight separate environments. They 
are accessed by clicking on the relevant icon in the Environments shortcuts 
panel (see Figure 1). Once opened, each environment can also be accessed by 
clicking on the relevant Environment tab below the toolbar or by choosing the 
relevant environment from the “Window” drop-down menu. 

 

 Information environment 

This environment contains information about the run generated by the 
output.csv file. This information includes machine serial number, application, 
and plate name. Comments can be added or deleted using the “Add 
Comment” or “Delete Comments” buttons. 

 

 Plate environment 

This environment shows information about the samples on the plate being 
analyzed. Predefined information includes the sample name (if entered in IS 2.3 
software) and total number of beads analyzed per well. Sample information 
that must be added by the user before data analysis includes the type of sample 
(e.g., background, control, or standard) and sample dilution factor. A 
breakdown of the data can also be displayed for each analyte. Groups of 
replicate samples can also be defined in this environment. 

 

 Analytes environment 

This environment displays in tabular form both raw data (e.g., bead count and 
raw MFI) and values calculated after analysis. A breakdown of the data is 
displayed for each analyte. 

 

 Samples environment 

This environment displays the same data and information that is displayed in 
the “Plates” environment in tabular form.  Sample and replicate information 
can also be directly entered in this environment. 
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 Kit Setup environment 

The Kit Setup environment enables users to define parameters for the 
calculation of the concentration of each analyte (e.g., whether or not to carry 
out a subtraction of background or to define a particular analyte as an internal 
control). The concentration of each standard and limits for acceptable data 
values are also defined on this environment. 

 

 Diagnostics environment 

The “Diagnostics” environment allows users to apply diagnostics algorithms to 
their data in order to filter out inconsistent or low-quality data. 

 

 Analysis environment 

The “Analysis” environment performs regression analysis on the standard curves 
and generates results for the unknown samples and a graphical representation 
of standard curves. 

 

 Replicates environment 

The “Replicates” environment displays average results, %CV, and SD values for 
identical samples defined as groups in the “Plate” or “Samples” environments. 
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Analyzing xMAP Data Using LiquiChip Analyzer 
Software 
The process of analyzing xMAP data can be broken down into 8 steps. 

 Loading raw xMAP data (see page 9) 

 Defining sample types (see page 10) 

 Entering standard concentrations (see page 14) 

 Performing a diagnostics data check (see page 21) 

 Generating standard curves (see page 14) 

 Analyzing raw data using the parameters entered in the first three steps 
(see page 15) 

 Analysis of sample replicates (see page 25) 

 Export or printing of data (see page 26) 
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Opening and Loading Raw xMAP Data Files Using 
LiquiChip Analyzer Software 
1. Launch the LiquiChip Analyzer Software by clicking on the icon on 

the desktop. The “Information” environment is automatically 
opened. 

2. Open the output.csv file using the File > Open command or the icon 
on the toolbar. 
Machine serial number, application, and plate name are displayed. 
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Defining Sample Types 
Defining the location and type of sample on a plate is performed in the ”Type” 
window or column of the “Plate” or “Samples” environment respectively. In the 
“Plate” environment the sample information is displayed in a 96-well plate 
format, and in the “Samples” environment in a table format (see below). To 
enter sample type information in the “Plate” environment click on the “Well” 
radio button and choose “Type” from the drop-down menu (see below). 

Tip: When working in the “Plate” environment, highlight and copy the 
information in the “Well” > “Name” fields. Select “Type” from the drop-down 
menu, and paste the information into the corresponding wells. Overwrite the 
“Name” fields with the “Type” information. This saves having to switch between 
“Name” and Type” fields while defining sample types. Information in the 
“Name” and “Total Beads” fields is imported from the output.csv file. 

 

 
“Plate” environment 
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Entering sample information 

The location and type of each sample is entered by highlighting the relevant 
well(s) (“Plate” environment) or cell(s) (“Samples” environment) and clicking on 
the corresponding button in the toolbar, or by copying and pasting defined 
wells or cells. 

There are four types of sample that can be defined: 

 Unknown Sample (? on the toolbar) — wells containing test samples 
whose concentration is calculated on the basis of the standard curve 
defined using the selectable standards 

 Sample background (SB on the toolbar) — “blank” wells. The MFI value 
in wells defined as SB can be subtracted from test values to normalize data. 

 Selectable standards (S1–Sn on the toolbar) — wells containing the 
dilutions of standards which make up the standard curve. Define the most 
dilute standard as S1, the next most dilute as S2, and so on. 

 Controls (C1=1st level control, C2 = 2nd level control, etc.) — wells 
that contain “internal controls” that serve as reference values for unknown 
samples. 

Automatically defining and entering multiple standard sample types 

LiquiChip Analyzer Software allows multiple standard sample types to be 
defined and entered in the “Plate” or “Samples” environments. The example 
shown below is performed in the “Samples” environment. 

1. Define the multiplicity of the wells containing standard-curve 
samples using the drop-down menu on the toolbar. 
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2. Select the standard level with which you wish to begin the series 
(usually S1) in the “Selectable standard” drop-down menu in the 
toolbar. 
Note: The standard levels define each concentration in a dilution series. For 
example, when using a standard curve containing 8 duplicate points from 
blank to most concentrated, define the two blank wells as SB, the most 
dilute standard wells as S1, the next most concentrated as S2, and so on 
until S7, the most concentrated (see below). 

 

 
 
3. In the “Type” column, highlight the cells corresponding to the 

standard wells. 
 

 

“Selectable 
standard” 
button 
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4. Click on the “Selectable standard” button in the toolbar. 
The software automatically defines the highlighted wells as standard wells 
with the desired multiplicity. 

 

 

 

Generating average analyte values from identical samples 

Average analyte values for multiple identical samples can be obtained by 
defining the relevant samples as groups. An average analyte result, %CV, and 
SD are displayed in the “Replicates” environment for all wells that are assigned 
an identical identifier in the “Group” window (“Plate” environment) or column 
(“Samples” environment) (see page 25). 
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Entering Standard Concentrations 
Concentrations of standards that make up the standard curve(s) are entered in 
the “Standards” tab of the “Kit Setup” environment. 

Manual entry 

Values can be entered directly into the relevant cells, or copied and pasted from 
spreadsheets. 

Automatic calculation of dilution concentrations 

LiquiChip Analyzer software can automatically calculate and enter standard 
serial dilution concentrations. 

1. Enter the concentration of the most concentrated standard (e.g., S7 
for an 7-point standard curve). 

2. Highlight all the cells that correspond to the standard serial dilutions 
(including the most concentrated standard). 

3. Select the relevant dilution factor from the drop-down menu in the 
toolbar or enter a custom value. 
The dilution factor will appear in the toolbar button. 

 
4. Click on the dilution button in the toolbar. 

The concentration of each dilution is automatically calculated and entered 
into the relevant cell. 
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Analyzing Raw Data 
Once raw data has been loaded, well types have been defined, and standard 
concentrations have been entered, standard curves and the analyte 
concentration in unknown samples can be calculated. This analysis is 
performed in the “Analysis” environment. 

 

 
 

Standard curves and calculation of the concentration of unknowns is performed 

by clicking the either the  “Calculate Selected Analyte” or  (“Calculate All 
Analytes”) button on the toolbar.  

Calculated concentrations of unknown samples can be viewed in the “Result” 
field of the “Analytes” environment. 
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Advanced Features 

“Plate” and “Samples” environments 

There are further parameters that can be defined in the “Well” screen of the 
“Plate” environment and “Samples” environment: 

 Group — this function is used to define groups of identical samples. The 
identifier for each group is a group name. After analysis, the software 
averages the results for all the wells in a group to give a mean analyte 
value, %CV, and SD. 

 Dilution Override — any dilution factor defined here will be used to 
calculate the concentration of a sample, irrespective of any other dilution 
information entered in other locations (see below) 

 Dilution Multiplier — this function is used to modify any dilution factor 
applied across the entire plate (defined in the “Kit Setup” environment). For 
example, if the “Dilution factor” defined in the “Kit Setup” environment is 5, 
applying a “Dilution Multiplier” of 10 to a well will result in a total dilution 
factor of 50 being applied. 



 

LiquiChip Analyzer Software Basic Users Guide   02/2006 17 

“Kit Setup” environment 

 
The “Information” window of the “Kit Setup” environment contains fields in 
which “Kit Name”, “Lot Name”, and “Dilution factor” information can be 
entered.  

The “Component Lots” window can be used to record lot information on the 
reagents used in the assay. 

The large window in the “Kit Setup” environment displays either the “Analytes” 
or “Standards” window, depending on the chosen tab. 

“Analytes” window 

The following parameters can be defined in the “Analytes” window of the “Kit 
Setup” environment. 

 Name — names of analytes are imported from the output .csv file. 

 Bead ID — bead code information, imported from the output .csv file.  
This information cannot be altered. If the bead-code information were 
changed, analysis would not be possible.  
Note: If data are imported from IS 2.x software, the bead codes are 
automatically reassigned a new value from –1 to –x. If you wish to import 
the data in a particular order open the following tab in the IS Software 
Tools>Options>Data Export. In the Test Sort Order field click on 
Alphabetical by Test Name — to export data arranged alphabetically 
according to the test name 
Sequential by Region ID — to export data arranged according to 
increasing bead code 
Template Setup Order — to export data arranged according to the order 
of template setup  
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 Normalize Front to Back 

 None — default value. 
 Front-back standards — choosing this option applies an algorithm to 

the assay results that takes the “plate effect” into account when 
calculating final concentrations. This feature can only be used when 
two identical standard curve dilutions are present in the first and last 
columns of an assay. 

 Internal Control 

 Yes — choosing this option enables an analyte to be defined as an 
internal control. 

 No — default value. 
 Background Subtraction 

 Yes — Default value. Choosing this option subtracts the average value 
in wells defined as “Sample Background” in the “Plate” or “Samples” 
environments (see page 10) from raw MFI values. These values can be 
displayed by choosing “Normalized MFI” in the drop-down menu in 
the “Analyte” screen of the “Plate” environment or in the “Analytes” 
environment. 

 No — shows raw MFI values. 
 Correction Factor — any multiplication factor entered here will be used in 

calculating the final result. This feature is useful for correlating data to 
given external standards (e.g., WHO standards). 



 

LiquiChip Analyzer Software Basic Users Guide   02/2006 19 

“Standards” window 

The following parameters can be defined in the “Standards” window of the “Kit 
Setup” environment. 

 Units — the units used to define concentrations (e.g., pg/ml) can be 
defined here. 

 Recommended Formula — drop-down menu allowing choice of analysis 
algorithm. 

 4PL and 5PL — Logistic 4- or 5-point fitting. 
 4PL (Log) and 5PL (Log) — Logistic 4- or 5-point fitting using logs of 

the raw data. 
 External — imported curve-fitting algorithm. 
 Best fit — default value which applies all the above algorithms to the 

data until the best fit is found. 
 Limits — sets absolute limits on MFI or concentration values below or 

above which they will be rejected. 

 Relative — Default value. Uses the minimum and maximum standard 
MFI values to reject data lying outside these boundaries. 

 None — All data values will be accepted. 
 Fixed — uses fixed MFI or concentration values to reject data. 
 External — uses imported limits to accept or reject data. 

 Minimum Concentration — minimum concentration below which 
calculated concentrations will be rejected. The value entered will be applied 
as a fixed or relative value (see above). For example, if the chosen units are 
ng/ml and “Fixed” is chosen in the “Limits” field, entering 20 will reject all 
values below 20 ng/ml. If “Relative” is chosen in the “Limits” field, entering 
0.2 will reject all values below 20% of the minimum standard 
concentration. 

 Maximum Concentration — maximum concentration above which 
calculated concentrations will be rejected. The value entered will be applied 
as a fixed or relative value (see above). For example, if the chosen units are 
ng/ml and “Fixed” is chosen in the “Limits” field, entering 200 will reject all 
values above 200 ng/ml. If “Relative” is chosen in the “Limits” field, 
entering 0.9 will reject all values above 90% of the maximum standard 
concentration. 
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 Minimum MFI — minimum MFI below which data will be rejected. The 
value entered will be applied as a fixed or relative value (see above). For 
example, if “Fixed” is chosen in the “Limits” field, entering 20 will reject all 
MFI values below 20. If “Relative” is chosen in the “Limits” field, entering 
0.2 will reject all values below 20% of the maximum standard MFI. 

 Maximum MFI — maximum MFI above which data will be rejected. The 
value entered will be applied as a fixed or relative value (see above). For 
example, if “Fixed” is chosen in the “Limits” field, entering 20,000 will 
reject all MFI values above 20,000. If “Relative” is chosen in the “Limits” 
field, entering 0.9 will reject all values above 90% of the maximum 
standard MFI. 
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“Diagnostics” environment 

This environment allows users to apply diagnostics algorithms to their data in 
order to filter out inconsistent or low-quality data. The “Diagnostics” 
environment window contains 5 diagnostics algorithms which can be toggled by 
clicking on the relevant algorithm. Active algorithms are indicated by a checked 
box. Clicking on the “Run” button starts the diagnostics check. 

 Low Bead Count – absolute — this algorithm checks the absolute number 
of beads in each well and generates a warning for wells in which the 
number of beads is below a defined minimum value. 

 Low Bead Count – relative — this algorithm checks the number of beads in 
each well. It generates a warning for wells in which the number of beads is 
more than 2 standard deviations below the median value. 

 Hook effect — this algorithm checks for saturation effects in standard 
curves containing high concentrations of analyte in a non-wash or non-
filtered assay. 

 Internal control — this algorithm detects the presence of an internal control 
bead and generates a warning for all wells in which it’s MFI value varies by 
more than 2 standard deviations. 

 High RP1 CV – relative — this algorithm generates a warning for all 
unknown sample wells in which the CV value is above a certain limit, 
relative to the analyte median CV values across the entire plate. Standards 
and controls are not checked. 
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“Analysis” environment 

In this environment, data are analyzed on the basis of information entered or 
imported into the “Samples”, “Analytes”, and “Kit Setup” environments. 

Standard curves and calculation of the concentration of unknowns is performed 

by clicking the either the  “Calculate Selected Analyte” or  (“Calculate All 
Analytes”) button on the toolbar.  

The equation used to fit the standard curve(s) can be defined by selecting the 
desired equation from the “Equation:” drop-down menu and clicking the 
“Calculate Selected Analyte” or “Calculate All Analytes” button on the toolbar. 

After a standard curve has been calculated, standards, controls, and unknowns 
can be displayed on or removed from the curve by toggling the  
(“Standards”)  (“Controls”), and  (“Unknowns”) buttons respectively. The 
buttons will appear orange when selected. 

The  (“View Previous Curve”) button allows comparison of curves generated 
by different fitting equations. 

The  (“Zoom”) button permits chosen section of the curve to be magnified. 

Using the drop-down menu on the  (“Axis”) button allows linear or 
logarithmic scales to be chosen for the x- and y-axes. 

Right-clicking on the graph opens a dialog box that allows display and export 
parameters to be defined. The graph can also be exported using the 
“Export”>”Graph” command in the “File” drop-down menu. 

Standard points 

Point information (status, well location, raw and normalized MFI) can be viewed 

by clicking on the  (“Information”) button and clicking on the standard point. 
This button is orange when active and gray when inactive. 

Standard points can be discarded from the fitting of a standard curve by 
clicking on the  (“Reject Standard”) button and clicking on the point to be 
rejected. This button is orange when active and gray when inactive. The 
standard curve can then be recalculated using the “Calculate Selected Analyte” 
button. 

Rejected standard points can be included the fitting of a standard curve by 
clicking on the  (“Accept Standard”) button and clicking on the point to be 
included. This button is orange when active and gray when inactive. The 
standard curve can then be recalculated using the “Calculate Selected Analyte” 
button. 
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Importing standard curves 

Data can be analyzed using an existing standard curve. To import the standard 
curve, select “External Standard Curves” from the “Import” command in the 
“File” drop-down menu. Select and open the .lxout file from which the standard 
curve is to be imported. Choose the standard curve(s) to be imported from the 
list in the dialog box. To analyze data using an imported standard curve, select 
“External” from the drop-down menu on the “Equation:” toolbar button. The 
analyte name in the data to be analyzed and the imported standard curve must 
be identical. Importing a standard curve and using its data for analysis is only 
possible if it was obtained using the same kit set up as the new assay.  

 

1. Import the external standard curve data by selecting 
File>Import>External Standard Curves… . 

 
 
2. Select and open the .lxout file from which the standard curve is to be 

imported. Choose the standard curve(s) to be imported from the list 
in the dialog box. 
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3. Choose the option “External” in the drop-down menu of the 
Equation: External toolbar. 

 
 

4. Recalculate the appropriate standard curve(s). 
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“Replicates” environment 

After analysis of data the “Replicates” environment enables a report on the 
“Groups” defined in the “Plate” or “Samples” environment to be generated. A 
basic report, giving the average value for each group is generated by clicking 
on the “Generate Report” button in the toolbar. The basic report displays the 
name of the group, in which wells the samples belonging to the group were 
present, and the average MFI and unit values for each checked analyte. 

 

To choose the fields that you wish to display click on the  (Fields…) icon in 
the Generate Report toolbar and check the relevant boxes. 

N — number of replicates 

MFI — mean of normalized replicate MFIs 

SD — standard deviation of normalized replicate MFIs 

% CV — % standard deviation of normalized replicate MFIs 

Scale — dilution factor deriving from Dilution Override or Dilution Multiplier 
(see page16) 

Result — mean of calculated replicate results 

SD — standard deviation of calculated replicate results 

% CV — % standard deviation of calculated replicate results 

 

A more detailed report displaying MFI and unit values for each well in the 
group can be generated by clicking on the  (“Show Details”) button next to 
the “Generate Report” button in the toolbar. 
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Exporting and Importing Data 
All values and definitions in the “Well” screen of the “Plate” environment and 
“Samples” environment (“Plate Information”) and in the “Kit Setup” environment 
(“Kit Information”) can be imported or exported using the “Import” and “Export” 
commands in the “File” drop-down menu. “Plate Information” is stored as a 
Plate template (.lxfmt) file. “Kit Information” is stored as a Kit template (.lxkit) 
file. 

Analyzed data can be saved using the “Save” or “Save As” commands in the 
“File” drop-down menu. Data is saved as an Output (.lxout) file. 

Handling data 
Information in any data field can be imported from or exported to other 
spreadsheet-type programs (e.g., Microsoft® Excel). Information in grayed-out 
cells can be accessed or blocked by toggling the  (“Show/Hide grid headers”) 
button on the toolbar. Other buttons in the toolbar are useful for manipulating 
data in cells. 

 Replicate Cells Right — copies the value(s) in the first column of a 
highlighted block of cells into all highlighted cells to the right of the first 
column. 

 Replicate Cells Downward — copies the value(s) in the top row of a 
highlighted block of cells into all highlighted rows below. 

 Swap Cells Vertically — flips values in a highlighted block of cells vertically 
about the central axis. 

 Swap Cells Horizontally — flips values in a highlighted block of cells 
horizontally about the central axis. 
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QIAGEN Companies 
Please see the back cover for contact information for your local QIAGEN office. 

QIAGEN Distributors 
Argentina 
Tecnolab S.A. 
Tel:   (011) 4555 0010 
Fax:   (011) 4553 3331 
E-mail:  info@tecnolab.com.ar 
Web site:  www.tecnolab.com.ar 
 
Brazil 
Uniscience do Brasil   
Tel:  011 3622 2320  
Fax:  011 3622 2323 
E-mail: info@uniscience.com  
Web site: www.uniscience.com 
 
Chile 
Biosonda SA 
Tel:  562 209 6770 
Fax:  562 274 5462 
E-mail: ventas@biosonda.cl 
Web site: www.biosonda.cl 
 
China 
Gene Company Limited 
Tel:   (852)2896-6283 
Fax:   (852)2515-9371 
E-mail: 
Hong Kong: 
info@genehk.com 
Beijing: 
info_bj@genecompany.com 
Shanghai:  
info_sh@genecompany.com 
Chengdu:  
gene@public.cd.sc.cn 
Guangzhou: 
info_gz@genecompany.com 
 
Croatia 
INEL Medicinska Tehnika d.o.o. 
Tel:   (01) 2984-898 
Fax:   (01) 6520-966 
E-mail:   
inel-medicinska-tehnika@zg.htnet.hr 
 
Cyprus 
Scientronics Ltd 
Tel:  02-357 22 765416 
Fax:  02-357 22 764614 
E-mail: 
a.sarpetsas@biotronics.com.cy 
 
Czech Republic 
BIO-CONSULT spol. s.r.o. 
Tel/Fax: (420) 2 417 29 792 
E-mail: info@bioconsult.cz  
Web site: www.bioconsult.cz 
 
Denmark  
VWR International A/S 
Tel:  43 86 87 88 
Fax:  43 86 87 90 
E-mail: info@dk.vwr.com 
Web site: www.vwr.com 

Egypt 
Clinilab 
Tel:  52 57 212 
Fax:  52 57 210 
E-mail: Clinilab@link.net 
 
Estonia 
PEAI-Est OÜ 
Tel:  (051) 65 830 
Fax:  (07) 383 360 
E-mail: langel@ut.ee 
 
Greece 
BioAnalytica S.A. 
Tel:  (210)-640 03 18 
Fax:  (210)-646 27 48  
E-mail: bioanalyt@hol.gr 
Web site: www.bioanalytica.gr 

 
Hungary 
Kasztel-Med Co. Ltd. 
Tel:   (01) 385 3887 
Fax:  (01) 381 0695 
E-mail:  info@kasztel.hu 
Web site:  www.kasztel.hu 

 
India 
Genetix 
Tel:  (011)-2542 1714 
  or  (011)-2515 9346  
Fax:  (011)-2546 7637 
E-mail: genetix@nda.vsnl.net.in 

 
Israel 
Westburg (Israel) Ltd. 
Tel:  08-6900655 
  or  1-800 20 22 20 (toll free)  
Fax:  08-6900650 
E-mail: info@westburg.co.il 
Web site: www.westburg.co.il 

 
Korea 
LRS Laboratories, Inc. 
Tel:   (02) 924-86 97 
Fax:   (02) 924-86 96 
E-mail: webmaster@lrslab.co.kr 
Web site: www.lrslab.co.kr 

 
Malaysia 
RESEARCH BIOLABS SDN. BHD. 
Tel:  (603)-8070 3101 
Fax:  (603)-8070 5101 
E-mail: biolabs@tm.net.my 
Web site: www.researchbiolabs.com 

 
Mexico 
Quimica Valaner S.A. de C.V. 
Tel:   (55) 55 25 57 25  
Fax:   (55) 55 25 56 25 
E-mail:  ventas@valaner.com 
Web site: www.valaner.com 

 

 

New Zealand 
Biolab Ltd 
Tel:  (09) 980 6700  
  or  0800 933 966 
Fax:  (09) 980 6788 
E-mail:  
biosciences@nzl.biolabgroup.com  
Web site: www.biolabgroup.com/nzl  
 
Poland 
Syngen Biotech Sp.z.o.o. 
Tel:  (071) 798 58 50 - 52 
Fax:  (071) 798 58 53 
E-mail: info@syngen.pl 
Web site: www.syngen.pl 
 
Portugal 
IZASA PORTUGAL, LDA 
Tel:  (21) 424 7312 
Fax:  (21) 417 2674 
E-mail: consultasbiotec@izasa.es 

 
Saudi Arabia 
Abdulla Fouad Co. Ltd. 
Tel:  (03) 8324400 
Fax:  (03) 8346174 
E-mail:  
sadiq.omar@abdulla-fouad.com 

 
Singapore 
Research Biolabs Pte Ltd 
Tel:  6777 5366 
Fax:  6778 5177 
E-mail: sales@researchbiolabs.com 
Web site: www.researchbiolabs.com 

 
Slovak Republic 
BIO-CONSULT Slovakia spol. s.r.o. 
Tel/Fax: (02) 5022 1336 
E-mail: bio-cons@cdicon.sk 
Web site: www.bioconsult.cz 

 
Slovenia  
MEDILINE d.o.o. 
Tel:   (01) 830-80-40 
Fax:   (01) 830-80-70  
  or (01) 830-80-63 
E-mail: mediline@siol.net 

 
South Africa 
Southern Cross Biotechnology  
(Pty) Ltd 
Tel:  (021) 671 5166 
Fax:  (021) 671 7734 
E-mail: info@scb.co.za 

 
Spain 
IZASA, S.A. 
Tel:  (93) 902.20.30.90 
Fax:  (93) 902.22.33.66 
E-mail:  consultasbiotec@izasa.es 
 

 

Taiwan 
TAIGEN Bioscience Corporation 
Tel:  (02) 2880 2913 
Fax:  (02) 2880 2916 
E-mail: taigen@ms10.hinet.net 
 
Thailand 
Theera Trading Co. Ltd. 
Tel:  (02) 412-5672 
Fax:  (02) 412-3244 
E-mail: theetrad@samart.co.th 
 
Turkey 
Medek Medikal Ürünler 
ve Saglik Hizmetleri A. S. 
Tel:  (216) 302 15 80 
Fax:  (216) 302 15 88 
E-mail:  makialp@med-ek.com 
 
All other countries  
QIAGEN GmbH, Germany 
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Australia  Orders 03-9840-9800  Fax 03-9840-9888  Technical 1-800-243-066 

Austria  Orders 0800/28-10-10  Fax 0800/28-10-19  Technical 0800/28-10-11 

Belgium  Orders 0800-79612  Fax 0800-79611  Technical 0800-79556 

Canada  Orders 800-572-9613  Fax 800-713-5951  Technical 800-DNA-PREP (800-362-7737) 

China  Orders 021-51345678  Fax 021-51342500  Technical 021-51345678 

Denmark  Orders 80-885945  Fax 80-885944  Technical 80-885942 

Finland  Orders 0800-914416  Fax 0800-914415  Technical 0800-914413 

France  Orders 01-60-920-920  Fax 01-60-920-925  Technical 01-60-920-930 

Germany  Orders 02103-29-12000  Fax 02103-29-22000  Technical 02103-29-12400 

Ireland  Orders 1800 555 049  Fax 1800 555 048  Technical 1800 555 061 

Italy  Orders 02-33430411  Fax 02-33430426  Technical 800 787980 

Japan  Telephone 03-5547-0811  Fax 03-5547-0818  Technical 03-5547-0811 

Luxembourg  Orders 8002-2076  Fax 8002-2073  Technical 8002-2067 

The Netherlands  Orders 0800-0229592  Fax 0800-0229593  Technical 0800-0229602 

Norway  Orders 800-18859  Fax 800-18817  Technical 800-18712 

Sweden  Orders 020-790282  Fax 020-790582  Technical 020-798328 

Switzerland  Orders 055-254-22-11  Fax 055-254-22-13  Technical 055-254-22-12 

UK  Orders 01293-422-911  Fax 01293-422-922  Technical 01293-422-999 

USA  Orders 800-426-8157  Fax 800-718-2056  Technical 800-DNA-PREP (800-362-7737) 

 


